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Introducién

¢ Antes de enfrascarse na creacion de proxectos, imos ver como xestionalos en Eclipse.
¢ Imos ver como importalos e as opciéns existentes.

« E bo botarlle unha ollada ao seguinte material, para evitarse sorpresas desagradables coa perda de proxectos.
e Como xa se indicou recoméndase a lectura do seguinte documento: "Mi primera hora con Eclipse™:
http://ubuntulife.files.wordpress.com/2008/03/intro_eclipse_espanol.pdf

Iniciar Eclipse

e Como xa se viu na Unidade 1, imos comezar abrindo o Eclipse como se fose a primeira vez.
¢ Escolleremos a perspectiva de Java.

¢ O Workspace ¢ o lugar onde Eclipse almacena por defecto os proxectos e informacion sobre estes nunha carpeta chamada .metadata, que
pode traer algunha que outra complicacion.

¢ |niciar Eclipse

° - lr-'r.-rh'-_:par_.\! Launcher
Select a workspace

Eclipse stores your prajects ina felder called a workapace,
Choose a workspace Folder ba use For this session

(UE L ETET o me/ladmin/workspace Browse. ..

Wse this as the default and do nat ask again

Canced QK

Escoller se se desexa que pregunte polo directorio do Workspace a proxima vez que se inicie.
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Escoller a perspectiva Java.

Crear un proxecto

¢ Un usuario pode ter varios Workspaces ou outros cartafoles para organizar os seus proxectos. Asi, pode ter proxectos de distintas materias
ou distintas linguaxes en distintos Workspaces.

* Un proxecto pddese crear no cartafol do workspace ou noutra calquera. En calquera caso, almacenarase informacién sobre os proxectos no
cartafol .metadatos do Workspace co que se estea a traballar.

¢ Agora imos traballar con proxectos lixo para estudar as distintas opciéns, logo mais en diante explicarase os campos dos cadros de didlogo.

e Estes proxectos borrarémolos ao finalizar este apartado.

¢ Crear un proxecto lixo
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Indicamos nome da aplicacion: Proxecto1.
OLLO! Edicién 2015: Indicar como SDK minimo API 16.

Hew Ardrold Application
Configune Project

B Create custom launcher ion

B Create actisity
Miark this praject as a library

B creabe Project inwarkspace

working sets

Add praject o working sets

¥ <Back [ NERER ] Cancel
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Observar que o proxecto vaise crear dentro do Workspace.
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Indicamos o0 nome da actividade: Proxecto1.
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E na carpeta correspondente ao Workspace.
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Proxecto1 dentro da carpeta do Workspace.
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Contido do cartafol Proxecto1. Coincide co contido do Proxecto1 do IDE.

Rede

Cambiar de workspace

e Crear mais proxectos lixo

. afe Launcher

Select a workspace

Eclipse stones your projects ina folder called a workspace.
Chaase a workspace Falder to use For Ehis session

workspace: | fhomey/ladimin/IELSmITe " Browse...

Use this as the defaulk and do not ask again

Cancel 2.4

Pechamos e abrimos Eclipse, indicamos un novo Workspace para outros proxectos: workspaces2.
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O proxecto creado no novo Workspace. Ollo non esta o Proxectot.

Opsen File
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Premendo en File->Switch Workspace podemos cambiar de Workspace ou ver os dispoiiibles, premendo en Other. Neste menu € onde se
pode cambiar de workspace, cando na pantalla de inicio non temos habilitada a opcién de escoller.

Workspade Leuncher

Select a workspace

Eclipse stores yowr projects ina Folder called a workspace,
Choose a workspace folder to use for this sesslon.
waorkspace: | fhomefladminfwerkspacez ﬁ Browse.

fhomefladminfworkspacez

¢ Copy Setth Fhomefladmin/workspace

& cancel [

Tamén se pode pode engadir outro Workspace.

Workspace Launcher

Select a workspace

Eclipse stores youwr projects in a Folder called a workspace.,
Choose a workspace Folder bo use For this sesslon.

warkspace: |homefladmin/TEILEEIE - B GwSe. .
¢ Copy Settings G
i cancel [

Neste caso imos engadir o workspace3.

workspace Launcher

Select a workspace

Eclipse stores your projects in a folder called a workspace.
Choose a warkipace Molder bo e Mor thic sestion

Workspace; ,l'hnmelfl_a.dmln;mrt;pacej " Browse...
Mhomefladminfworkspacel
fhomefladminfworkspace? [}
fhomefladminfworkspace

Ui Lhis &% the delsult and do not ask again

Cancel QK
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Pechar Eclipse e volvelo abrir. Observar como agora ofrece os 3 workspaces.

wWorkspace Launcher

Select a workspace

Eclipse stores yaur projects in a fodder called a workspace

Choose a warkipace Molder bo uwme Por this session

Warkspaoe; IW - Browse..,

e this &g the default and do not ask again

Cancel ! QK |

Escoller o Workspace3, sera como partir de cero ...

‘|~ Java - Eclipse

{f PackageExplor 2 = O

Pero como saber en que Workspace estamos?. Hai a posibilidade de indicalo na barra de titulo.
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O ficheiro <ruta instalacion de eclipses>/eclipse.i

ladmin@ubase: ~

ladmin@ubase:~$ sudo gedit /fopt/eclipse/eclipse.inti

(A imaxe amosa como facelo en Linux. En Windows editar o ficheiro).

... podemos editalo
. *eclipse.ini (fopt feclipse) - gedit

Ficheiro Editar Ver Buscar Farramentas Dy

R R

*eclipseini x

EJ_.EL'._!_.E n
startup

pluginsforg.eclipse.equinox., Launcher _1.3.8.vZD
==launcher.library
plugins/org.eclipse. equinox. Launcher . gtk. Linux
-product 1
org.eclipse.epp.package.jee.product

- -launcher.defaultAction
openFile

showsplash
org.eclipse.platform

--lLauncher . XXMaxPermsize
256m

- -launcher .defaultaction
openFile

- -launcher . appendVmargs

vRargs

Dosgi.requiredlavaVersion=1.4

XX :MaxPermSize=256m

- XRs40m
-¥nx512n
Engadir ao principio: -showlocation.
o ¢ Java - Eclipse - fhomefladmin/workspace3

# PackageExplor 2 = 0O

L
= -

Pechar Eclipse e volvelo abrir. Observar a ruta do espazo de traballo na barra de titulo.
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Aqui vemos os cartafois dos tres proxectos.

Organizacion de proxectos dentro dun workspace: Working Sets

e Xa vimos que se poden ter diferentes workspaces para que o0 usuario se organice como desexe.

¢ Pero dentro de cada Workspace, Eclipse, ofrece a posibilidade de organizar os proxectos en agrupamentos chamados: Working sets.

¢ En todo momento podemos mover proxectos dun Working set a outro, ter un proxecto en varios Working sets, decidir que Working sets
amosar/ocultar, etc.

¢ Crear workingsets

Java - Eclipse - fhomefladmin/workspace3

File Edit Refactor Source Navigate Search FProject

[ = & - AR C R

]

# PackageExplor 2. = O

L

* 2 Proxecto3
» = Proxectod

k=% ProxectoJava
No workspace3 crear 2 proxectos Android: (Proxecto3 e Proxecto4) e un de Java (ProxectoJava1)

workipaoed

3 M Cartafol pevsoal workspaced
Lugares
O Recentes ‘ ‘ d
™ Cartalod persoal Prozectal Proxectod Froxectolaval
[ Escritoria
4 Descargas ‘
[ Documentos RemoteSystemsTe
B Imaxes mpFiles
-

O contido do Workspace3.

(o Project Explorer ¥ | = O

* = Proxecto3
* = Proxectod

View Menu

* = ProxectoJaval
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(View Menu)

Na Vista de Exploracion de Proxectos premer no Menu da Vista

Java = Eclipse - fhome/ladminfworkspace3

T

@ PackageExplor | & O

= L4

* 2 Proxeciod Top Lewvel Elements
¥ = Proxectod Select Working Set.
M- e

1 Window Waorking Set
Eilters...

Package Prasentation
v Show "Referenced Libraries’ Node

Link with Editor

Seleccionar Working Set...

select working Set

Seleck a working set;

window Working Sets
@ Mo Working Sets

Selected Working Sets

L_-?.,' Cancel (a4



https://manuais.iessanclemente.net/index.php/Archivo:Android_2013_U2_eclipse_33.jpg
https://manuais.iessanclemente.net/index.php/Archivo:Android_2013_U2_eclipse_34.jpg

Crear un Working Set novo.

Select a working set type -
working set for Java elements o

Waorking st type:
{9 Resgurce
@4 Braakpoint
o lava
=
= Tasks and Resources
i JavaScriph
4= Plugdins and Fragments

)

= | Cancel
-.ﬁ:_—._.l__

Podemos crear Working Sets para agrupar, recursos, programas, etc. Neste caso imos escoller Java, pois son proxectos de Java (Android)
0s que imos agrupar.

Java Werking Set

=
|
D Mo resources selected, é

Working set name:

Waor kﬁatr content: Warking set conbent:
* 2 Proxectod Add -

» & Proxectod

k= Proxectodaval

* = RemoteSystemsTempFiles

Agdd Al -=

< Back M Cancel _ Finlsh

Pofer un nome ao agrupamento: neste caso Java.

Java Werking Set

=
|
(I No resources selected. d

working set name:
Java

workspace content: Waorking set content:
* 2 Proxectod Achd = &
ki Proxectod

S e

¥ & FemoteSysbems TempFiles

I?x = Back M Cancel
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Seleccionar que proxectos o compofien ...

Java Werking Set

=
|
Enter a working set name and salect the working set elements, &
wWorking set name:
Java
workspace content: Waorking set content:

* i Proxectod 0 . & proxectodaval

» 2 Proxectod Arkda
=
* = RemotesystemsTempFilas

< REmave

<= Remowe All

i) < Back M Cancel

... neste caso imos pasar o ProxectoJavai.

Select a working sel
window wWorking Sets
i® Mo Working Sets

Selected Working Sets
5 Java New.. b
Edit...

Remowve

Select all Deselect all

L) Cancel ok

Crear outro agrupamento ...

lava Working Set

(Mo resources selected

Working set name:

[Fiateg 3

wigrkspace content: working set content:
F 3 Proxectod

* i Proxechod

Add all-=

k= Proxectodaval

* = Remotesystems TempFiles

it = Back lexi> Cancel _ Finish L
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... neste caso co nome Platega Android. Nesta ocasion, a modo de exemplo, non engadimos ningln proxecto.

-

Select a working set:

‘Window Working Sets
Mo Working Sets

® Selected Working Sets

& Java MEw,
~ & Platega Android
Edit....
Remove
Select all Deselect All
il Cancel JI—

13 PackageExplor . = 0O

® & Pramectad * Projects

* 1 Proxectod

Select Working Set...,
* i@ PromectoJava )

1 window Working 52t
Filters. .

Package Presantation :
« Show 'Referenced Libraries' Node

Link with Editor

No Menu da Vista, imos indicar que queremos ver os proxectos organizados por Working Sets.

Select and sort working sets wsible in Patkage Explorer

W 15 Dther Progects
w5 Java
B 15 Platega Android
Select All

Deselect All

Sart working sets

MHew...

i cancel |
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Podemos configurar que Workings Sets queremos configuar. Marcamos todos, entre eles: Other Projects. Tamén podemos indicar en que
orde desexamos ver os agrupamentos na Vista de Exploracion de Proxectos, para iso usaremos os boténs Up e Down.

Java - Eclipse - fhomefladmin/workspace3

Source Mavigate Search Proj

# PackageExplor 2| = 0O

= i =
‘& Other Projects
* == Proxecto3 L}

» = Proxectod

v {5 Java
» = ProxectoJaval
15 Platega Android

No agrupamento Other Projects podemos ver que estan os proxectos que non se asignaron ao agrupamentos creados anteriormente.

* I - Jawva EE - Eclipse - fhome/ladminfworkspace3

Run wWindow Help

l Proje
i {15, ), T

{5 Project Explorer 2 = O

= e o

* 15 Java Top Level Elements "

ki Proxectolaval rﬁs—avﬁ—ﬂ-—éﬁjﬁ-—m—-—.
15 Platega Android

LD eseleck Working Set

Package Presentation k
Customize View..

Link with Editor
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Premendo en Select Working Set podemos editar e crear novos agrupamentos.

C ung £

Setect ard sort working sets wisible in Package Ekﬁllﬂrl':‘l'
& %5 Other Projects Up
o Java
< @ Plabega Android
Select all
Desetect AN
Sort working sets
Hew... Edit.... h_ Aemowve
L Cancel -
Editamos o agrupamento de Platega Android.
Java Working Set i
Enter a working set name and select the working set slements,
Working set name:
Platega Android
Workspace conbent: ‘Working et content:
E 1= Procectolaval 2 == Proxectal
> i RemoteSystemsTempFiles
Add all-=
=- Remave
%= Femove &l
1 Cancel _ Finish |

Asociamos os proxectos de Android a ese agrupamento. Observar como o ProxectoJaval, tamén se poderia asignar a este working set, de
modo que ese proxecto estaria en 2 agrupamentos.
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Configune

Setect ard sort working sets wisible in Package Ekplnrer
& %5 Other Projects up
w5 dava
# © Plabegs Androdd
Select all
Deselect AR
Sort working sets
MHew... [Edit. Aemove
L Cancel s [: ]

Premer en OK.

€ PackageExplor 2| = 0O

15 Other Projects

T 45 Java
k = ProxectoJaval

T 45 Platega Android Filters...
* = Proxecto3 Package Presentation »
* = Proxectod ¥ Show '‘Referenced Libraries' Node

Link with Editor

Os proxectos organizados nos Working Sets. Indicar que no canto de todo o anterior poderiase ter arrastrado e soltado os proxectos dun
agrupamento a outro na presente pantalla. Volver a editar a configuracion ...
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Setect and sort '.'\-“.'lrhll'lﬂ sels visible in Package Exploner:
5 Other Projects Up
=00
® ¥ Plabega Android
Seleck AlL
Deselect All
Sodt warking sels
Hew Ediit.. Remayn
)] cancel oK
] P

Neste caso imos decidir que so queremos que se amosen 0s proxectos do agrupamento Platega Android.

Java - Eclipse - fhome fladmin/workspace3

Re or Source Mavigate Search

¥ PackageExplor 2| = O

1
|_ e,
=

¥ 15 Platega Android
» =5 Proxecto3

& proxectod

E ai o esta !l!

Java = Eclipse = fhome fladminfworkspace3

2 Package Expler 2| = 0O
k& Proxectod Top Level Elements
* 14 Proxectod

* 1= Proxectodaval

Warking Sets

Select Working Set...
Deselect Waorking Set

= 1 window Werking Set
Filters...

Package Fresentation »
« Show 'Referenced Libraries’ Hode

Link with Editar
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Se queremos ver os proxectos independentemente de como estean agrupados, ... seguir o menu da imaxe.

2 PackageEspler B2 5 O

= &5 Other Projects
* = Proxectod
* 2 Proxectod

Projects

Configure Waorking Sets._.

v i Java Filbers...
& i Proxsclolaval Package Presentation k
= Platega Android " Show "Referenced Libraries' Node

Link with Editor

Ou velos agrupados en agrupamentos.

Importar proxectos

» Os proxectos pédense levar dun equipo a outro simplemente copiando os cartafoles no que estan.
» Neste caso vanse copiar 0s proxectos contidos no Workspace3 a un novo cartafol chamado probas e logo importaranse.

e Importar proxectos

lugeret Lugares

& Aecentes ‘ 3 Recentes ‘
A Catalal parsal Prokectnd ™ Cartafol peryosl Promecied
I Escritoario [ Escritaiis

+ Descarges ‘ & Descangas ‘

Proxectod O bocumentos Prissctcd
B imanes

o M ‘ &3 Misica ‘
H videos Proxectolava H videss PT et aia
E Lixo m Leeiz
Deisp ositiwed ‘ Dispoaitivas

M computadar “':'F"'-:-'f::.;:'r\-p Bl:-.:mmuu;r
Hude Rede

SR Eaplorar arede &R Explosar a rede

B conectarseaunse... E.\ D conectareaunse,. [

B /5 ol S

Select a workspace

Eclipse stores your projects ina folder called a workspace.
Chaaose a workspace Folder ta use For this session

wierkspace: | fhomefladmin/workspace - Browse

fhomefladminfworkspace3

fhomefladminfworkspace?
homefladminfwarkspace . 1

Use this as the default and do not ask again

Cancel | oK
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Pechar Eclipse e seleccionar o Workspace workspace.
d Eclipse - fhomefladmin/workspace

File Edit R or )

I8 PackageExplore 8 = 0O

i T -
= “Lh.
= =1

[+

Este xa contifia o Proxecto1. Observar como non estan os agrupamentos creado no workspace3.

Eclipse = fhomefadmingeorkspace

Opan File..,

Close all Shiftec

oW,
HEna
Aefresh
ot Ling Delmiters Ta

Saitch warkspace 0
Restart

Smear ]

Expoart
Progertisg

1 Praxectod java [Promectatfsagfoamy..]
2 actwity proxectolaml [Proaschoif...]

Expt
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Premer en File -> Import

Select

Select an impert spurce:

¥ o Gesneeral
Wi Archive File
= Existing Projects into Warkspace
4, File System
L Preferences
¥ = android

F = CfCos
=
F = BB

B 2=, R

i

u&mmﬁ Cancel

¥ Existirg Androld Code inte Workspace

Indicar que é un proxecto de Android.

Import Projects

@ Selbect a directory te search for existing Android prejects

Root Directony:
Projects:

Progect to Import Mew Project Mame

Copy projects into workspace

‘Waorking sets

Add project be working sets

i « Back b Cancel

©

|,
Select all

Desebect All

refresh
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Seleccionar o cartafol probas ...

" AN

Lugares

Q Buscar

& usado recente...
s ladmin

@ Escritorio

e Sistema de Fich...
i Documentos

i Mdsica

[m Imaxes

B videos

il Descargas

& ladmin | probas

Nome

i Proxecto3

il Proxectod

il ProxectoJaval

N

Import Projects

Selact a directory Lo search Mor existing Androdd projects

foot Directory: | fhomefladmin/probas

Projects:

Projpect bo mpart
B Prosectad

B Prozectod

B ‘Copy projects into workspace
wWorking sets

Audd project to working sets

< Back

Mew Project Mame
I

Proxecied
| Proxected

Cancel

.. € automaticamente busca os proxectos que hai na carpeta probas e nas stas subcarpetas (ideal para corrixir proxectos). Observar que
non quere importar o proxecto de Java.

S

Browse._

Select AN
Deselect AR

Refresh
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Indicar que queremos que copie os proxectos do cartafol orixe ao workspace. Co cal se se modifican os proxectos, estes seran os que
estean no workspace e non no cartafol probas.

d Eclipse - fhomefladmin/workspace

=+ PackageExplore 82| = 0O
= =
- A proxectol

» == Proxecto3
» & Proxectod [y

Proxectos importados ...

4 Package Explore

Lugares Lugares
* i Promecto 1 | 1 Recentes ) Recertes d
® @l Promeciod M Cartal M Cartal Promectod
& o Pronsched BEcrito... [ Escritario
& Descar... e ‘
O Doum... Praxectal [ Docum I ———
G imiznsts B imaxes
dd Misica ‘ & Misica J
H videas Proxetod Hvideos Prosscbo lwval
[ Lizer B iha b
Dispositivos ‘ Diispasitivas
M comg... RemokeSystemsTe -2
maFiles B compu

E tamén copiados ao Workspace. Observar que proxectos estan/ou non en cada cartafol. A partir de agora co cartafol probas pddese
realizar o que se desexe.

Proxectos fora do Workspace

* Nesta ocasién imos ver como ter proxectos féra do Workspace. Ainda asi este é necesario para conter o cartafol .metadatos que conten
informacién, entre outras cousas, sobre os proxectos.
* Obviamente, tamén se poden ter outros proxectos dentro do Workspace.

e Crear proxectos féra do WorkSpace
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Workspace Launcher

Salect a workspace

Eclipse sbores your projects ina Folder called a workspace,
Choose a workspace Folder to use For this session

workspace: [fhomefladmin/workspace? - Browse

fhomefladminfworkspace
fhomefladminfworkspace3

| fhome/ladminjworkspace?

Use this as the default and do nok ask again

Camcel i O

Abrir de novo Eclipse no espazo de traballo workspace2.

Java - Eclipse - fhome/ladmin/workspace2

f8 PackageExplore 22 = O

{ -

o

* = Proxecto2

¥

Contén no workspace o Procexto2 creado ao principio.

Java - Ecllpse - fhome fladminfworks

Jawa Project
, Android Application Project

g1 Project...

Package

Class

Interface

Enum

Annatation

Saurce Folder

Java working Set

Falder

File

Untitled Text File

Android XML File

JUnit Test Case

Task

Example...
Qther_.
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Crear un novo proxecto de Android ...

Rew Androld Applicatisn
B The presfis 'com. example.’ (s meant a5 8 placelodder and should raot B used

Application Mames | Proxectas

R

Progect Hames® Proxectas

Package Hame s omexample pramcias

Minimum Requined SENCE 010 Androad 2, 2 (Fropa) i
Terget SCE-# AP 1B: Android 4.3 =
Comgile Withe® AP 1E: Androdd 4.3 -

Therme:® | Mola Light with Dark Actsan Bar =

¢ The apalication mame is shown s ithe Play Storce, 85 well 22 in the Menage Spplication
list in Setiergs

z oc (| e

Nome Proxecto5.
OLLO! Edicién 2015: Indicar como SDK minimo API 16.

Kew Amndrold Application
Coefigare Project

B Create custom lsunches icon

B Create activity
iehark s progect as a library

Create Project imWaorkspace

Lacatior: | fhomefadmintworkspacelPranecios Broease...

b

working sets

Adsd progect bo working sets

oy <ack . Wemiz Caroed
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Na ruta indicar que se desexa crear noutro cartafol féra do workspace.

Rew Androld Applicatisn
Coafigare Project

B Create custom launches icon

B Create actrty
fehari this project as alibrary

Creake Project imWorkspaoe
Lacakl o _nc-ﬁe,-'dcmun-mm Biores,..

Wiorking sats

Add progect to working sety

= fack LT TS [ 1

Ruta para o Proxecto5 féra do espazo de traballo.

Blank Activity
Creabes a new blank actvity, with an action bar and epticnsl nersigational elements such a5
tabs or horizontal swipe

ALRiADY N | SRR
Laynut Mames activily proeiias

Hadgation Tyee® Move

o Thakt fidarreis & I Ehii SeOENETY Clarks Lo CT Gl

(%]

= Bk Canal ; mﬁ'
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Nome da actividade Proxecto5.

4 Package Explore | Luganes

= @ Recentes J

LT r Frosecto?

* i Pronecto?
* i Prowectas (1=

v g & Descar ‘

mpFiles

k)] ProsectoS @) imanes

* i com.exampl [ Dacum FamateSysiem

1 Lugares
O Recentes ‘
uf M Cartaf Pramscios
[ Excritorio
il o Dmscar... &
Te D Docum..
o

o EImazes

Comparativa entre o IDE e os 2 cartafoles: o do workspace e o que conte? o proxecto5.

e Importar proxectos féra do Workspace

Open File...

Close all

Refresh

Cormert Line Delimibers To

Swibch Workspace

Restart

Export.. !

Importar de novo ...

Select

Sebect an import source;

F = Gereral

¥ = Android
® existing Android Code Into Workspace
* 2= CfC+
» = CVS
e ]
* = Gt
* 2 jnatall
* = Java EE
¥ = Maven
I (= B Mowedaarama ek
iy Hguk >

Cancel
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Proxectos de Android ...

Impart Projects
Select a directory to search for existing Androdd projects e
Root Directory: | /homefladmin/probas B,
Projects:
Project bo Impart Mew Projeck Name select All
& Proxectod | Promsctod Desciect Al
Refresh

Copy projects inte workspace
Waking sets

Add project to working sets

'J = Back - Cancel | Finish

Pero ... esta vez non copiar os proxectos ao espazo de traballo. O resultado sera semellante ao anterior. S6 que agora os cambios que se
fagan nos proxectos 3 e 4 seran gardados no cartafol probas.

1 eprkgie faply LEgusst Lusgarea |
= LN ‘ Q) Ewraisn ‘ D 2wy ‘
e pe— Pl A Carta Frasms Framnisl
[prp—— WFnara .
L ‘ & b & Cwncargas d
¥ i ot D D OO LT O e, [t Priuiriod
- IR e B wnane Biimase
T F - LRV ddeainics ‘
e Hvidein Hidaza B i i R

Observar como se distriblen os 4 proxectos do IDE: 1 en workspace2, 1 no cartafol chamado 'proxectos_fora e 2 no cartafol probas

Borrado de proxectos

¢ Os proxectos pédense borrar dende Eclipse:
+ Pddese borra s6 o enlace no IDE, sen borrar os ficheiros do proxecto,
+ Ou tamén o cartafol que o contén os ficheiros do proxecto.
e Tamén se poden borrar os cartafoles directamente, pero teriase no IDE un enlace a un proxecto que non existe.

e Borrar proxectos

Java - Eclipse - fhome fladminfworkspace2

Mew
e Go nka

Openin Mew Window
Open Type Hierarchy F4

¥ Package Expl Sho in SHIFL+AILLW o

Copy Crl+d
: Copy Qualified Name
* i Proxecto2 Chrlavy
* = Proxectol TR
» & Proxectod | W

* = Proxectos

Build Path b
Source shift+Alt+5 »
Refactor hift+Alt+T »
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Borramos o Proxecto2.

9 Are you sure pouwant to remove project "Proxecto?’ From the workspace?
Delete project contents ondisk (cannct be undone)

Project lecation:

fhame/ladmin/warkspaced/Prosecto?

P i = Cancel (a1

Pero non o borramos en disco.

Fouyrd prohlems

Mo ol infarmation sEilable

= Bach Cancil Conline

Unha advertencia ... Seguir...

File Edit Refac

workspace2
+  workspace2
'# Package Expl¢ Lugares
= O Recentes

*» = Proxecto3 M Cartaf...
> .2 Proxectod | IMESCrito...
» & Proxectos w Descar... ‘

() Docum... RemoteSystemsTe

@ Imaxes mpFiles
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Vemos que o IDE non ten o Proxecto2, pero este segue no cartafol workspace2.

=y Go Into

Open in New Window
Open Type Hierarchy
Show In shift+Alt

Copy
Copy Qualified Name

Build Path

Eniireg ChifFk g A

Borramos o Proxecto?2.
6 Are you sure youwant to remowe project 'PFroxectad’ from the workspace?
& Delete project conbents on disk (cannot be undone)

Fr%crr location:
fhome/ladmin/probas fProxectod

Preview s cancel | [EHE

Esta vez si 0 borramos no disco.

probas

probas
Lugares
@ Package Explorel
& Recentes
3
= 1 M Cartafo... Proxecto4
F = Proxectod B Escritorio

F == Proxecto5 & Descargas J

0 bocum... FroxectoJaval
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Nin no IDE nin no cartafol probas esta o Proxecto3.

Preferencias: workspaces
¢ Rematamos revisando onde se almacena a configuracion relativa aos workspaces anteriores.

» Preferencias

° Java - Eclip

Mew BTN - =
Open File
aQ

Refresh
Corveert Lire Delimiters Ta '

Sithworpsce [ ——
Restart Hamefadmin/workspace
kmpcik Ctheer [x

Observar os espazos de traballo disponibles.

Eclipze - flome flad miin fwork

Mew wirdow

Hidke Toulbae

2 Packageixplore B & O Dpen Perspactie
Shuya Vigw '

Customize Perspective
Saue Perspective As..
Biset Perspechi.

Close Perspactive

Close All Pers pactives

P Prosectod
* i Progectod

HMavigalian "
Ardraid SOE Manager

Anddiroid Vit Device B ana g
Bupn A ndrcsdd Lind '

Premer en Window -> Preferences.

L[]
| Workspaces b w =
'.I:';:;:I;qmp B Proemptfor workspace on startup
Capabilities Hurmnber of recert workspaces to remember: |5 2
CompaseiPatch Aecent workspaces
Conbent Types homeTadminfeoskspace? Eerrowh
b Editors fhomse ladminfworks pace
Kiys Thomdladmin/works paced
* Mebwark Connechics
Perspectives
Search
k Seoarity
sarvoe Paligies
T Startup and Shutdcd
Workspaces
Tracing
inlgh Browses

* iNorkspace
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En General -> Startup and Shutdown -> Workspaces podemos eliminar a referencias aos espazos de traballo que se vifian usando até
agora. Tamén podemos configurar se queremos que siga preguntado/ou non, ao iniciar Eclipse, polos espazos de traballo.

L]
(W ‘Workspaces W w
¥ Ceneral
B Prosmpt for workspace on startup
LR
Capabilities Humber of recent workspaces to remember: |5 °
Compase/Patch fecent workspaces
Content Types ThomeTadmin/woskspace Remaove
* Editors h‘
Ky
b Metwark Connectios
Perspectives
Search
k Sgourity

Serdce Paligies

a

Skartup and Shutdo
workspaoes

Tracing

inieh Browses

* Workspace

Deixamos s6 espazo de traballo workspace.

lava = Eclipse - fhome fladminfworkspacez

Open File_.

Refresh
Conert Line: Delimibers To I

Restart Other...

Impart..
Agora xa s6 hai ese espazo de traballo.

Cartafol persoal

W Cartafel perical p

Lugares

G Recerites ﬂﬂ - T ‘
m Imanes Modetas I

B Ezeritaria

& Descargas ‘

[ bocum... | probas |

B Imaxes

dd padisica d ‘

H videos Ubunty O Videas

& Lixa

Dispasithvas ‘ ‘
@ compat... [ workspace? | warkipace |

Rede

B Exploca d

Canmect 4 cartalobes seleccionados {conbendo un
- r -y | FI. T fy
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3 £ Cartafol persoal

™ Cartafol persoal

Para limpar todo imos borrar os cartafoles que usamos até agora, salvo ...

Lugares -
© Recentes ‘] - 1
M Cartafo... Descargas Documenktos Escritorio
[ Escritorio = ;
revisod I R
[ Dacum... Imaxes Maodelos Misica
B Imaxes
dd Misica '! ‘
Hvidens Piiblico Uhuntu One Videns
{0 Lixo

Dispositivos - = -
[ comput... contacks2.db Exemplos

Rede D}

... workspace.

-- Angel D. Fernandez Gonzalez e Carlos Carrién Alvarez -- (2015).
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